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Limited Warranty - CardTool® reader and/or CardVisor® software 

TokenWorks™ Inc. (hereafter “TokenWorks”) warrants the TokenWorks CardTool® reader, the 
CardVisor® software, and this Manual, hereafter jointly or individually the “product” IN ITS ENTIRETY, 
to be in good working order for a period of 90 days from the date of purchase. Should this product fail 
to be in good working order at any time during this warranty period, TokenWorks will, at its option, 
repair or replace this product at no additional charge except as set forth below. Repair parts and 
replacement products will be furnished on an exchange basis and will be either reconditioned or new. 
All replaced parts and products become the property of TokenWorks. This limited warranty does not 
include service to repair damage to the product resulting from accident, disaster, misuse, abuse, or 
modification of the product performed without the prior written approval of TokenWorks. 
 
Limited Warranty service may be obtained by sending the product during the warranty period to 
TokenWorks. Before sending material, please obtain a Return Material Authorization (RMA) number by 
requesting one from TokenWorks.  To obtain additional return and contact information, visit 
www.tokenworks.com.  If this product is to be returned you agree: (a) to insure the product or 
assume the risk of loss or damage in transit; (b) to prepay shipping charges to the warranty service 
location, and (c) to use the original shipping container or equivalent. 
 
ALL EXPRESS AND IMPLIED WARRANTIES FOR THIS PRODUCT, INCLUDING THE WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR PARTICULAR USE, ARE LIMITED IN DURATION TO A PERIOD OF 
90 DAYS FROM THE DATE OF PURCHASE, AND NO WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
SHALL CONTINUE BEYOND SUCH PERIOD. EACH PURCHASER UNDERSTANDS THAT THE 
TOKENWORKS PRODUCT IS OFFERED AS IS. TOKENWORKS AND ITS SUPPLIERS ASSUME NO 
RESPONSIBILITY FOR ANY DAMAGE OR LOSS CAUSED BY DELETION OF DATA AS A RESULT OF 
MALFUNCTION, DEAD BATTERY, OR REPAIRS.  BE SURE TO MAKE BACKUP COPIES OF ALL IMPORTANT 
DATA ON OTHER MEDIA TO PROTECT AGAINST DATA LOSS.  
IF THIS PRODUCT IS NOT IN GOOD WORKING ORDER AS WARRANTED ABOVE, YOUR SOLE REMEDY 
SHALL BE REPAIR OR REPLACEMENT AS PROVIDED ABOVE. IN NO EVENT WILL TOKENWORKS BE 
LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE SUCH 
PRODUCT OR FOR ANY CLAIM BY ANY OTHER PARTY, IRRESPECTIVE OF ANY NOTICE TO TOKENWORKS 
OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIM. 
 
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS, WHICH 
VARY FROM STATE TO STATE. 
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Age Verification Calculation Limitations 

The CardVisor application is warranted to read the date of birth information encoded on the machine-
readable (magnetic or 2D bar code) stripe and display the current age based on current date/time 
information contained in the handheld computers real time clock (RTC).  It will also read other 
information on the stripe and present it to the operator. It should be understood that the displayed age 
may differ from the actual age of the person presenting the card for any one of a number of reasons. 
Among the most likely are: 
 

• the card does not belong to the person presenting it, 
• the encoded machine-readable stripe has been altered,  
• the date of birth presented to the issuing authority was misrepresented, 
• the issuing authority mis-encoded the date of birth on the card, 
• the handheld computer real time clock is not set to the current date/time. 

 
The above list of reasons is not exhaustive. 
 

State and Local Privacy Laws, Ordinances or Rules 

Some states and local government units regulate the who, how and what information from a driver’s 
license can be electronically viewed or recorded.  Check with the authorities in your jurisdiction before 
using the CardVisor product.  Purchaser is wholly responsible for insuring full compliance with the laws 
of the jurisdiction wherein the product is to be used.  TokenWorks fully disclaims any liability for any 
loss, damages or untoward circumstances that may arise from the inappropriate use of the product or 
of the data retrieved through its use. 
  
 

Copyright  

Printed in the United States of America 
 
3511 Silverside Rd.  
Suite 105 
Wilmington, DE 19810 
www.TokenWorks.com (Company Web Site) 
www.CardVisor.com (Product Web site) 
support@tokenworks.com 
 
 
Copyright 2002 -> 2004 TokenWorks, Inc. 
Information in this document is subject to change without notice. No part of this document may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, 
without the express written permission of TokenWorks, Inc. 
 
TokenWorks, CardVisor and CardTool are trademarks of TokenWorks, Inc. 
Visor and Handspring are trademarks of Handspring Inc. 
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Document Information 

 
 EVOLUTION OF THE DOCUMENT 

Version Date Author Evolution 
UM-040102-CC-R0 4/1/2002 CC First draft  

UM-040102-CC-R1 4/2/02 PC Review 

UM-040102-CC-R2 5/9/02 CC Added Red highlights to Excel import screen shots  

UM-040102-CC-R3 6/19/02 PC Review, Warranty 

UM-040102-CC-R4 7/31/02 CC Updated for Release 3 of CardVisor 

UM-040102-CC-R5 10/24/02 CC Revise for final Release of CardVisor I, II, & III 

UM-040102-CC-R6 11/07/02 CC CardVisor III material moved to separate manual 

UM-040102-CC-R7 12/19/02 CC RawData Category, Button Preferences, Hard Reset, 
Trouble shooting chart, Exporting data from Palm 
Desktop 

UM-040102-CC-R8 1/20/03 CC Adding notes to swipe data (e.g. Banned/VIP indicator, 
phone, email info), Graffiti table. 

UM-040102-CC-R9 3/23/04 CC Append Note Feature (CV III feature) and non-duplicate 
subsequent swipe feature.    
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About This Document 

This document should be used in conjunction with the Handspring Visor user manual (on the 
Handspring CD or available on-line at Handspring.com) and the CardVisor Quick Reference Guide (on 
the CardVisor CD or available on-line at CardVisor.com). If reading Bar Codes, then please also 
reference the Bar Code Reader Cradle Quick Reference Guide (on the CardVisor CD or available on-
line at CardVisor.com) for important information on scanning 2D bar codes.   
 
The CardVisor age verification system consists of a version of the CardVisor software, a CardTool® 
reader, a Handspring Palm OS handheld computer, a HotSync cradle, connectivity software, and an 
optional bar code reader cradle with internal Li-Ion battery & charger.  The bar code reader is 
necessary for licenses with a 2D bar code and no magnetic stripe (see coverage map for details). 
 The CardVisor system has a large transaction log, which saves the last 6,000 scans.  It can 
process 6,000 cards on a single battery charge and the magnetic stripe version is all packed into a 
pocket sized 1”Dx3”Wx6”H. It is ideal for checking IDs wherever and whenever it’s most convenient.   
 All versions of the CardVisor software save the basic driver license data with a date/time 
stamp.  CardVisor II software adds the ability to record name, address and gender information, vital for 
enhancing customer contact.  CardVisor III software adds a real-time VIP / Banned patron look-up 
capability to identify individuals when their license is swiped.  It also allows notes to be appended via 
the main screen to the saved data for email, phone number, etc.  
 The CardVisor system is very configurable.  You determine what the age threshold should be 
(18, 19, 20, and/or 21).  Each can have a different audible alarm sound.  The age display can be set 
for years (YY) or years/months/days (YY,MM,DD).  There is even a long and short version of happy 
birthday which can be played if desired!  
 An optional 2D bar code cradle upgrade is designed for reading government issued drivers' 
licenses and ID cards, and sets a new benchmark for readability and ease of use. No need to "aim" or 
"focus", simply insert and remove the card.   
 
Features 

● Calculates Age based on encoded Date of Birth and provides visual and audible alarm if underage or 
expired. 

● Scans Magnetic and PDF417 bar code driver’s licenses with optional Bar Code reader cradle.   

● Stores the last 6,000 parsed & unparsed license scans. 

● License scan data can be PIN code protected  

● Scroll, search and delete license data on device—no PC required. 

● Transaction download software and cables included. No extra software to purchase. 

● Configurable Audible Alarm on Under 18, Under 19, Under 20 and Under 21 check settings. 

● Easy to use large touch screen display (160 x 160 pixels) with backlight.   

● Small handheld form factor—Magnetic stripe only version slips into a shirt/coat pocket (only 3”W x 1”D x 
6”L )  - with optional Bar Code reader cradle, 3” to 5”W  x  2.5”D  x 10”L is handheld or desktop mounted. 

● Handheld runs for weeks or 6,000 license swipes on 2 self contained alkaline or rechargeable NiMH AAA 
batteries.   

● Configure Age display as years (YY) or years, months, days (YY,MM,DD) 

● Includes Palm OS handheld computer with built in Palm applications Address book, Date book, Note 
Pad—run other Palm PDA applications 

● Optionally Plays Long, Short Birthday Song 

● Optional VIP/Banned Database capability (CardVisor III) 
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Encoded Stripe (Magnetic & Bar Code) – Formats & Reliability 

Formats 

The CardVisor ID scanner reads encoded information off the encoded (magnetic or 2D bar code) stripe 
of drivers license or ID card.  While most states have the same basic information on the encoded 
stripe, the locations and format differ.  From time to time, states will change how they encode the 
information on the stripe.  Additionally, since most do not read what they’ve encoded, they sometimes 
make mistakes that become part of the issued card population. This may cause difficulty in parsing 
the data.  When the software is unsure, it creates a memo in the MemoPad application that starts with 
the phrase “Trouble Parsing this data ->…” If you see a Memo like this, then please email it to 
support@tokenworks.com or email the entire MemoPad file (MemoPad.dat) and you will be one of the 
first to receive a software update that address this new license format.    
 
The CardVisor ID scanner saves the original or ‘raw data’ from the encoded stripe as a separate memo 
in the MemoPad application.  This unparsed driver's license data is given the RawData category in the 
MemoPad application (see category in top right part of MemoPad screen).  This is done to provide a 
convenient method to cross check the parsed information, provide technical feedback to TokenWorks 
(new license formats) and record the additional fields from the driver's license such as eye color, 
weight, etc.  
 

Reliability 

Driver licenses are exposed to varying conditions in a typical 4 to 6 year life cycle.  Unlike credit cards, 
Driver licenses are not frequently swiped nor are they typically replaced if the encoded stripe is 
damaged.  Therefore, read performance will vary with older licenses in typically poorer condition.    
 
For licenses with Magnetic stripes, it is possible to read just Track 2 of a license since it is encoded at 
a lower bit density than tracks 1 and 3, and less sensitive to damage.  Track 2 has the driver’s license 
number, date of birth and expiration date.  If the name does not appear on the screen, it is possible 
that Track 1 has become unreadable while track 2 is still readable.  Note: The software must be able 
to read track 2 information to display the age and card status. 
 
For licenses with 2D bar codes, make sure the bar code is not damage and that all foreign material is 
removed before reading.  The level of error correction incorporated into the bar code varies between 
states so some states will scan with quite a bit of damage while others will not with just minor 
damage.  
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Inserting the CardTool 

To insert the CardTool, align the unit with the Handspring expansion slot (see figure 1) and gradually 
insert the unit.  It should insert smoothly until it makes contact with the expansion slot stops.  Do not 
force the unit into the expansion slot.  If resistance is significant, withdraw CardTool and ensure there 
are no foreign objects in the expansion slot and that CardTool is properly aligned with the Visor 
expansion slot.    

 
 
 
 

Swiping Magnetic Striped Cards  

 

1. With the CardVisor application running on the screen of the Handspring Visor, hold the unit in either the 
left or right hand.  If the CardVisor is not active, select the CardVisor application icon from the ‘desktop’ 
or ‘home’ screen that shows all the application icons. 

2. Using your other hand, position a magnetic card with the magnetic stripe (black stripe on back of card) 
facing the Handspring Visor at either end of the CardTool’s card slot. 

3. While ensuring that the magnetic card’s edge remains in contact and parallel to the base of the card 
slot, swipe the card completely through the card slot.   

4. It does not matter which way the card is swiped, but it is important that the card not be skewed during 
the swipe.  Skewing occurs if the card is tilted or rotated as it is swiped through the slot.  Tip: hold the 
magnetic card in the center and maintain pressure on the edge as it travels through the slot.  
Experiment with the orientation of the Handspring Visor.  Some find it easier to hold the Handspring 
Visor with the screen facing left or right and swiping the card vertically through the card slot.   

5. The ‘CardVisor’ application will update its display after a successful swipe and store relevant information 
it in the MemoPad database. 
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CardTool Removal 

To remove the CardTool, either use the thumb stop on the back of the unit to gradually push it out of the 
expansion slot or grab the CardTool at the base of the card slot and pull it away from the Handspring Visor 
in the same plane as the expansion slot.  Try not to grab the CardTool by the top and bottom but rather 
each side at the base of the card slot.  Grabbing the top and bottom of the CardTool will generate a force 
component, which will increase the friction and make it harder to remove. 

 

 
 
When the CardTool is removed from the Handspring Visor, the following takes place. 

Applications that were automatically installed when the CardTool was inserted are automatically uninstall 
from the Visor application menu. 

Note: If the Visor is turned off, removal of the CardTool (or any other module) turns the Visor on. 
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Helpful Hints 

Adjusting Screen Contrast 

 
Tapping the contrast icon with the stylus controls the contrast of the LCD display.  The contrast icon is 
the small black and white circle in the lower left corner of the pull down menu square; tap it and a 
sliding bar will pop up to allow you to adjust the contrast. 
 

 
      
   The contrast icon is here ----| 
 
 

 
 

Adjust the contrast by using the stylus to “grab” the slider bar on the contrast pop up. 
 

Screen Backlighting Feature 

 
There is a backlighting feature on the Visor, press and hold the power button down after you turn the 
unit on.  The backlighting is helpful in low light conditions. 
 

Reconfiguring Front Buttons  

See the Quick Reference Guide for how to make the front silver buttons turn on and launch the 
CardVisor ID Scanner application.  This is recommended for users who dedicate the unit to age 
verification. 
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CardVisor Application Installation 

 
After plugging in the CardTool, CardVisor automatically installs 
and welcome screen appears.  Click the OK button to launch 
the main screen of CardVisor, is shown below.  

Make sure the date and time displayed in the top right corner 
of the screen is correct.  To set the date/time, review the 
instructions provided in the Handspring User Manual or click 
on the ‘Prefs’ icon which is displayed after tapping the 
Applications Icon.  

 

Make Sure Date & Time at the top of the form is current 
 

  
CardVisor III Main Screen CardVisor II Main Screen 

Main Screen Description   

The main screen is where the magnetic card data and card status is displayed after each swipe.   At 
the bottom of the screen is a dialog box where messages are displayed.  In this area, card and status 
information is displayed after each swipe.  If the card swipe was unsuccessful, the message “Swipe 
Again” will appear 
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CardVisor Options Screen 

To access the options menu, click on the Menu Icon, just below the home icon in the graffiti area (see 
explanation below).  Depending on the version of CardVisor software, there are three or four items on 
the Options menu.  The Reset option will reset the CardTool hardware.  If the unit is not responding to 
a card swipe, try the reset option. 
 

  
Options Menu of CardVisor 
CardVisor I and II do NOT have the ‘Test 
VIP/Banned Database’ item.   

Screen After Reset Command. 
NOTE: field and append button only on 
CardVisor III. 

 
 
The ‘About CardVisor’ displays information on the 
application and its developer.  The ‘Reset’ item will reset 
the card reader and display the message “Swipe A Card” in 
the dialog box if successful.  If the unit still doesn’t work 
after reset, see the trouble shooting section in this 
document.  The ‘Age Threshold and Alarms’ item sets the 
age thresholds for various alarm events, alarm sounds, and 
display options.  See the Age Threshold and Alarm section 
in this document for additional details.  The ‘Test VIP / 
Banned Database’ item is only present in CardVisor III and 
should be run whenever a new Banned/VIP database is 
loaded into the handheld.   
 
 
 
 

What is the Graffiti Area? 

 
The Graffiti writing area is divided into two parts: one 
for writing letters, and one for writing numbers. The 
little "abc" or "123" at the bottom corners of the 
Graffiti writing area tell you where to write letters or 
numbers. You can also tap the "abc" or "123" to 
bring up the onscreen keyboard. 
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Age Threshold and Alarms   

The Age Threshold and Alarm screen configures at what age CardVisor will alarm at and what alarm 
sound will be played.  There are six sounds available for the under 18, under 19, under 20, under 21, 
and expired license conditions.  After selecting a new sound, CardVisor will play it before updating the 
display.  
 
The Expired alarm may not be disabled, only the alarm sound may be changed.  The Happy Birthday 
song may be disabled by un-checking the check box.  If checked, one may select either the long or 
short version of the Happy Birthday.  The Visual indication of a birthday will be displayed on the main 
screen status line.   
 
If the Age YYMMDD item is checked, then the age will be displayed in years months and days.  This 
allows one to see how close somebody’s birthday is and wish them a pre-happy birthday.  If un-
checked, then the age is displayed just in years.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Memo Pad  

CardVisor saves the track data to built -in Palm OS Memo Pad.  By storing data in this way, it may be 
HotSynced to a PC and subsequently imported into PC desktop applications.  For each swipe, two 
memos are created.  The first is the parsed data from the Driver License; First Name, Last Name, 
Address, City, State, Zip, Driver's License number, Expiration date (YY/MM), Year of birth (YYYY), 
MMDD of birth, the status of the swipe (e.g. OK), the date and time of the swipe.  Between each of 
these fields is a field separator characters (^).  This character is important when importing the data 
into programs like Microsoft ACCESS or Microsoft Excel.   

   
MemoPad showing all memo 
Categories 

Parsed Data in CardVisor 
Category 

Individual Memo showing 
parsed data 

   
Under 18 and Under 21 
age alarms configured. 

Pop Up menu for Under 
20 Alarm 

Happy Birthday Song – 
Long or Short Version 
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The second memo created is the original or raw decoded data from the driver’s license.  This shows all 
the information actually stored on the stripe.  It is collected primarily as a diagnostic tool to allow 
improvements in the parsing algorithms as states change encoding approaches.  Thus, with the 
customer feedback, it is not necessary to continually request license encoding changes from 50 motor 
vehicle departments.  If you see a license that is getting parsed correctly, please email both the 
parsed and unparsed memos to support@tokenworks.com.  Shown below is the unparsed information 
that is categorized as ‘RawData’ and a detailed view of the raw data.   
 
 

  
Unparsed Data in ‘RawData’ 
Category 

Individual Memo showing 
unparsed data 

 
 

Before a new rawdata Memo is stored in MemoPad, the last rawdata memo is compared to the new 
pending Memo.  If it is identical in every respect, including the date and time stamp, then the new 
memo is not stored.  If the new Memo differs in just the time, it is still stored.  This feature prevents 
redundant Memos for the same license swiped repeatedly in succession.    
 
 

Appending Notes to License Data (CardVisor III feature) 

CardVisor III software allows additional notes (up to 80 characters) to be added to the Parsed License 
Data Memo.  This is useful for recording marketing information such as phone numbers and email 
address or other significant information about an individual. 
 

   
After License Scan Input Note (email address) After hitting Append button – 

Note Confirmation Message 
 
Only one note can be appended to a license that is swiped successively.  In other words, if a license is 
swiped and a note is appended and the same license is swiped again and a new note is appended, the 
second note will replace the first note.  If a multiple field note is desired, then insert the ‘^’ character 
between each field when inputting the note.  
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Tip - Adding Notes to Swipe Data – Alternate to Append Note button  

After a license has been swiped, it is possible to add one or more comments that will be uploaded to one or 
more columns in the Excel spread sheet.  This is a great way for CardVisor III clients to mark a customer as a 
VIP or Banned individual.  It is also an easy way to record additional fields such as email addresses or phone 
numbers.  Whenever the Excel import wizard sees the ^ character, it puts the following data into the next 
column of the spreadsheet.  At the end of each parsed string (CardVisor Category Memo), there is the carat 
character.  Just tap the stylus at the end of the line and start making notes.  Notes can be made using the 
keyboard or via Graffiti (see Graffiti chart in this manual).                         

  
Insertion point showing cursor after last 
carat (^) character 

Adding data to a Memo entry using the 
‘Keyboard’ instead of Graffiti. 

 

 

 

 

 

 

 

 

 

 

Additional columns can be added to the spreadsheet by appending additional ^ characters.  See the Graffiti 
chart on how to write this character.  Note: It is not necessary to have a carat symbol as the last character in 
the memo.  Excel will put the last field in the proper column with or without a carat symbol at the end. 

 

  
Memo entry after adding ‘VIP’ to the 
end of the string 

Memo entry after adding ‘VIP’ & email 
address to the end of the.  Note:  ‘^’ 
character between fields 
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Maintenance and General Care 

¾ The CardTool is not waterproof.  Do not expose to rain or moisture. 

¾ Do not drop the CardTool or subject it to strong impact.   

¾ Protect it from temperature extremes.  Do not leave on the dashboard of a car on a hot day and 
keep it away from heaters and other heat sources. 

¾ Do not store or use your CardTool in any location that is extremely dusty, damp or wet. 

¾ Ensure the magnetic heads are occasionally cleaned with commercially available magnetic 
cleaning cards.   

 
¾ Clean exterior of case with dry lint free cloth and do not use abrasive cleaning products. 

 

Battery Life  

The CardTool does not have its own battery but instead uses the main batteries of the Handspring 
Visor.  When the CardTool is installed in the Handspring Visor, it will draw current from the main 
batteries and thus reduce the life of these batteries.  Every effort has been made to reduce the power 
consumption of the CardTool and this section should help users understand how the CardTool will 
change the normal life expectancy of the Handspring Visor’s main batteries. 
 
To conserve batteries, it is suggested that: 
 
¾ When not planning to read a card, either power off the Handspring Visor or select another 

application such as the address book, memo pad, etc.  This will put the CardTool into its sleep 
mode. 

¾ If not planning to use the Handspring Visor for an extended period of time, remove the CardTool 
and/or the Handspring’s main batteries (if applicable).   Informal testing has shown that the normal 
8-week alkaline battery life is shortened to approximately 3 weeks if this suggestion is not applied. 

¾ For Handspring Visors with built -in rechargeable Lithium Ion batteries (Prism, Edge, Pro), return the 
unit to the charging base whenever not in use.  Note: This is the normal operating procedure 
suggested by Handspring to ensure these models get their batteries constantly topped off.  

¾ For Handspring Visors using alkaline batteries, consider purchasing rechargeable NiMH AAA 
batteries.  A list of batteries/chargers is provided on the TokenWorks web site in the support 
section. 
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Trouble Shooting 

 

Problem Possible Problem Possible Solution 
Batteries on Visor are 
installed incorrectly. 

Reinstall batteries correctly.  Make sure the (+) and (-) signs on the 
batteries line up with the signs on the inside of the battery 
compartment. 

Batteries are dead Install new batteries 

Visor is hung After installing new batteries, remove the CardTool reader and 
perform a soft reset.  If this doesn’t work, try a different set of 
batteries.  If this fails, contact customer support.  

Unit does not power up – 
No screen display 

Hardware failure Contact TokenWorks Technical support Note: if Handspring Visor not 
purchased from TokenWorks, then contact Handspring technical 
support at www.handspring.com  

Magnetic stripe is dirty Clean stripe with soft cloth. 

Magnetic Card may be 
damaged 

Try another card. 

CardTool is hung Run Reset menu item from main menu.  If still experiencing 
problems, perform soft reset with stylus or paper clip 

Magnetic Card may be 
miss-aligned during 
card swipe 

Ensure card is being held flush to base of card track during swipe.  
Try swiping at different speeds, in a different direction, holding the 
card at different locations, or changing the orientation of the 
Handspring.     

CardVisor is not decoding 
card data - "swipe 
again"  

Firmware memory 
requires reflash 

Remove and reinsert CardTool reader.  If CardWelcome application 
automatically reflashes firmware, then this probably will resolve the 
problem.  If not, Remove and reinsert CardTool reader again.  Do not 
hit OK button to launch CardVisot but instead, select pull-down 
menu icon (below house icon in graffiti area), and tap on ‘reflash 
now’ menu item.  This will force a firmware reflashed.   

CardVisor does not 
respond to card swipe 
and does not display 
‘Swipe A Card’ message 
when first launched. 

Firmware memory 
requires reflash 

Remove and reinsert CardTool reader.  If CardWelcome application 
automatically reflashes firmware, then this probably will resolve the 
problem.  If not, Remove and reinsert CardTool reader again.  Do not 
hit OK button to launch CardVisot but instead, select pull-down 
menu icon (below house icon in graffiti area), and tap on ‘reflash 
now’ menu item.  This will force a firmware reflashed.   

CardVisor application not 
visible on Main 
application launcher 
screen 

Category not set to All 
or unfiled. 

Select All or unfiled in the top right corner of the screen.   

Swipe data not displayed 
in MemoPad Application 

The MemoPad 
Category is set to 
display only personal or 
business memos. 

Change Category to ‘All’ or ‘CardVisor.’  To see Unparsed license 
data, set category to ‘RawData’ 
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 HotSyncing the Memo Pad 

  The Palm Desk Top Application ships with the Handspring Visor on the Green CD, 
contains software that synchronizes PC applications and the Handspring Visor.  It is called the Hotsync 
Manager and if properly installed, the blue and red icon shown above should appear in the task bar in 
the bottom right corner of your screen.  If not, please make sure the Palm Desk Top application is 
properly installed.   
 
For the latest version, visit the Palm web site for a free copy at 
http://www.palm.com/support/downloads/win_desktop.html.  For information and questions on 
installing the software on the Green Handspring CD, visit the Handspring web site support section at: 
http://support.handspring.com/esupport/start/hsWelcome.jsp and click on ‘new users start here.’   It 
is also advisable to read the ‘Advanced HotSync Operations’ chapter in the Handspring User Guide 
that is also on the Handspring CD.   BEFORE HOTSYNC ANY DATA, MAKE SURE THE HOTSYNC 
PROGRAM IS PROPERLY CONFIGURED AND ALL IMPORTANT DATA IS BACKED UP.   
 
Also included on the Green Handspring CD is a program called Pocket Mirror that which will optionally 
install when installing the Palm Desk Top.  It causes HotSync to use Microsoft Outlook INSTEAD of the 
Palm Desk Top application.  These instructions require that Pocket Mirror IS NOT installed. If it has, it 
is possible to remove the application by going to the control panel, selecting add/remove programs, 
and removing it.  It can be installed again from the CD if needed.   
It is assumed that the reader is familiar with HotSync.  If not, it is advisable to read the ‘Advanced 
HotSync Operations’ chapter in the Handspring User Guide that is also on the Handspring CD.   
 
BEFORE HOTSYNC ANY DATA, MAKE SURE THE HOTSYNC PROGRAM IS PROPERLY CONFIGURED AND 
ALL IMPORTANT DATA IS BACKED UP.   
 

First HotSync Operation & Setting HotSync User Name 

Assuming the Palm Desktop software has been installed and that the HotSync manager is running (look for  

Hotsync icon  in system tray located in bottom right of the screen), it is time to perform the first HotSync 
which will ‘syncronize’ the data between the handheld and the Palm Desktop.  Place the handheld in the 
HotSync cradle or connect it to the PC with a HotSync cable and follow the directions on the next page.  If the 
HotSync window does not open on the Desktop computer: perform each of these steps in order.  After each 
step, try to synchronize.  If the HotSync operation succeeds, the problem is resolved and don’t try the next 
step. 

1. Is HotSync Manager on? Before you can synchronize, this software needs to be running. Turn 
it on if necessary.  

2. Perform a soft reset: Here's how. This is a great trick for solving a number of problems.  
3. Disconnect your device from the HotSync cable or cradle, and connect it again. Don't press 

the HotSync button until the device is fully connected.  
4. Failure to communicate: Make sure that your desktop computer and handheld device are 

communicating properly.  
5. Alarms pending? If any Calendar, To Do, SMS, MMS, voicemail, email or other alarms are 

awaiting a response from you, tap on "OK."  
6. HotSync configuration: Make sure you have the right cradle/cable, and your HotSync software 

is correctly configured. 
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Hit the HotSync button on the cradle/cable and the 
following dialog box will display.  Since this is the first 
Hotsync, there should be no user names so hit the 
‘New” button. Even if there are names already 
present, hit the New button.   

If an existing name is selected, then all the data 
associated with that name will be written to the 
handheld’s memory and all the license data will be 
saved in the selected user name which may already 
have other data.  So, hit the New button! 

 

 

Enter a New user name – use the date, e.g. 032204 
instead of a name.  This will help track subsequent 
HotSyncs and provide a means to retrieve historical 
data. 

 

 

After creating the new name, select it for the user 
name list and hit OK.   
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After hitting OK, the Hotsync Progress box should 
display and confirm the Hotsync is taking place. 

 

 

Once Hotsync is complete, launch the Palm Desktop application, set the User name to the one just 
created (see user name pull down menu in top right corner) and click on the MemoPad icon on the left 
menu bar.   Shown below is what the Main screen of the Palm Desktop with the Memo Pad active 
should look like.  Check that the number of Memos matches the number of Memos in the Handheld.  
On the left, the Memo is highlighted and on the right are its contents.  If there are no Memos and the 
HotSync operation worked, ensure that Pocket Mirror was NOT installed.  

 
Main Screen of the Palm Desk Top showing the Memo Pad 
 

Exporting Data from Palm Desktop  

The Palm Desktop application allows all or selected Memos to be exported in several common formats 
including comma delimited, tab delimited format, and text.  This document will use text since 
CardVisor puts field delimiters in the data (^ character) which the import wizard of Excel and Access 
can recognize.  To start the process, first select the memos, which are to be exported.  It is possible to 
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export all or just a subset of the memos to be exported by highlighting the desired memos.  Follow the 
directions below to export just the Memos which are categorized with the “CardVisor” Category. 
 
 
1.) Set the 
Category to 
“CardVisor”  - 
See Category 
box circled in 
RED on right. 
 
 
2.) Place the 
mouse cursor 
in the middle 
of the 
‘Description’ 
window and 
right click.  
This will open 
a small menu, 
select the 
‘Select All’ 
menu item.  
See RED 
circled on 
right. 
  
 

 

 
 
 
 
Then, from the main File menu, 
select the Export option.   

 
Palm Desktop –> File -> Export  

 
This will launch the Export As 
window that determines the file 
name, format and storage 
location.  
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Export As Window  
 

 
First select the file folder in 
the Export Window where 
the file should be saved.  
Use the Pull Down arrow to 
change directories.   
 
Then Set the Export type as 
Text (*.txt) as the file Export 
type  
 
Then set the Range for 
‘Currently selected records’ 
 
Finally, enter a file name 
that contains the date(s) of 
the license captures.  This 
will help identify the file 
later 
 
Click on the Export button. 
 

 

 

 
Important: Make sure the file extension is “ .txt” and not “ .csv” since files with the “csv” file extension 
will not cause the Excel import wizard to launch.  If accidentally used, the csv file extension can be 
rename to txt by the file manager and no harm will be done. 
 
After hitting the Export button, the program will ask which field of the Memo Pad should be exported.  
There are three fields in the Memo Pad application; Memo, Private and Category.  The Memo field 
contains the track data, the private field indicates whether the Palm OS should treat the record as 
private, and the last field is the category.  For this example, only the track data will be exported so just 
check the Memo items. 
 
 
Specify only the Memo Pad field for Export 
 

1.) Check the Memo item 
2.) Uncheck the Private and Category items 
3.) Hit the OK button 

 
 

 
After this window closes, the data will be 
exported and saved to the export file.  The 
Export complete message box should be 
displayed. 

 
 
 
The next step is to import the information into Excel or Access.  For this example, Excel will be used, as 
it is familiar to more people than Microsoft Access.  However, the import wizards for both products are 
very similar so these instructions would also apply to Access.   
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Deleting Data from Handheld 

After the license data has been transferred to the Palm Desktop application, the easiest way to delete 
the old license data from the Handheld is to do a Hard Reset.  By performing a Hard Reset, all the 
license data on the handheld will be erased and when the next HotSync is performed, select a new 
Hotsync user name, again using the date.  By HotSyncing with a new user name after each hard reset, 
each user name will hold the data for a specific time frame and provide a method to view historical 
data. 
 
Warning: A hard reset will erase everything on your device. 

REPEAT WARNING  - A HARD RESET WILL ERASE ALL TRANSACTION DATA 

Don't perform a hard reset unless you've backed up your data, or you're willing to lose everything.  

To perform a hard reset: 

1. Hold down the power (on/off) button on your device.  The power button on Visor organizers is on 
the front.  

2. While holding down the power button, turn over your device so that you can see the back of it. 
Using the reset tool, an unfolded paper clip or a similar small blunt-tipped object, gently press 
the reset hole on the back.   See Where's the reset hole in the CardVisor Quick Reference 
Guide. 

3. When the device's screen displays the Palm Computing Platform logo, release the power button. 

 

4. A message will appear warning that you are about to erase all the data stored on your 
handheld. In response, do one of the following:  

o Press the up scroll button on the front panel of your handheld to complete the hard 
reset, erasing everything on your device 
or 

o Press any other button to begin a soft reset, leaving your data intact.  
5. Your device will then take you through a series of screens to calibrate the digitizer and verify the 

time and date. 
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Note: A hard reset does not delete the current date and time. It does restore other settings to the factory 
default. . 
 
 
Remember that the next time a HotSync is performed; select a NEW HotSync user name, preferable 
one incorporating the current date.  By following this procedure, each HotSync user name will contain 
the license data from the previous HardReset date to the current HotSync date which will then allow 
for easy retrieval of historical license data. 
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Importing MemoPad Data to Microsoft Excel 

Excel and Access provide very nice data import wizards.  These instructions were based on Excel, but 
should apply to ACCESS. To use these wizards, from the main menu of Excel, select the File, Open 
item.   
 

1.) Click on the File -> Open 
menu item.  This will launch 
the Open Dialog box shown 
below.   

 

 
 
 
 
2.) Select the directory which 

contains the exported 
memoPad data. 

3.) Change the file type to Text 
Files (*.prn, *.txt, *cvs) 

4.) Select the correct file (e.g. 
export.txt) or type the correct 
file name into the file name 
text box. 

5.) Hit the open button. 
 

 

 
After pushing the Open button the 
Excel import wizard will launch.  This 
Wizard determines how the data in 
the file will be interpreted when 
imported in the Excel spreadsheet.  
 

1.) Select the Delimited radio 
button 

2.) Start import at row 1 
3.) File Origin Windows (ANSI) 
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In the second step, the Wizard asks 
how the fields are to be delimited.  
 

1.) Check the ‘Other’ delimiter 
option 

2.) Uncheck the tab, space, 
semicolon, and comma 
options. 

3.) Type the carat character ‘^’ 
into the ‘Other’ delimiter text 
box 

4.) Hit the next button 
 
Note:  Once you enter the carat 
character into the text box, the 
Wizard will put vertical lines in the 
Data preview window. Make sure the 
lines are shown in the appropriate 
locations before proceeding. 

 

 
The final step in the process is to 
indicate the format of the data in 
each column.   
 

1. Hit the Finish Button 
 
Note: For mailing labels, General is 
fine on all columns.  If certain 
information should be treated 
differently, this screen allows it to be 
formatted appropriately. 
 
That is basically it.  After hitting the 
finish button the data now has been 
imported into Excel. 
  

Shown here is what the imported 
data will look like in Excel.    
 
Note that the first name is in column 
A, the last name in column B, 
address in column C.  Also note each 
entry is in its own row and that in this 
example there are blank rows 
between each row of license data. 
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To remove the empty rows in the 

data, just hit the sort button . 
Or select the Data -> Sort menu item 
to sort the entire spreadsheet.  
 
 
 
Here is the spreadsheet after the sort 
button has been pushed.   
 

 
The final step in the process is to 
save the new Excel spreadsheet.  
Select the File -> Save As menu item.  
This will launch the Save As dialog 
window shown on the right.  Enter the 
desired file name and type.  In the 
example shown, the file type is 
Microsoft Excel Workbook (*.xls) and 
name is ‘export.xls.’ 
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Graffiti Table 

 
 
End of Document. 
 


